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Section 1 

Introduction 

This manual describes installation and operation of the ONBOARD 

SYSTEMS Data Card System and optional equipment.  

 

Please read the procedures and other information 

given in this manual before attempting to install 

or operate this system. 

Warnings, Cautions & Notes 

The following definitions apply to Warnings, Cautions & Notes used in 

this manual.  

 

Means that if this information is not observed, 

serious injury, death or immediate loss of 

flight safety could occur 

 

Means that there is a risk of injury or 

degradation in performance of equipment if 

this information is not observed.  

 

Draws the reader’s attention to information which 

may not be directly related to safety, but which is 

important or unusual. 
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System Overview 

The ONBOARD SYSTEMS Data Card System is a hook-load data 

recording accessory system designed to complement ONBOARD 

SYSTEMS E Series hook-load measuring systems. The data logging or 

recording system frees the pilot and ground personnel from the recording 

task by logging the hook-load weight, date and time, and duration for 

each lift. Summary totals and averages are also calculated. The recorded 

information can be printed directly or transferred to your computer for 

printing or further processing.  

The system integrates hook-load measurement with computerized data 

recording. While the measuring system measures the weight of lifts 

during a job, the data recorder displays flight and lift information, and 

stores a comprehensive record of this data. The data can be retrieved 

from the data recorder by inserting a data card or connecting a laptop to 

the data recorder serial port. Reports can be printed directly from the 

data recorder using the C-23 printer.  

The data card system complements your existing weighing system, 

providing an additional source of lift data that is rigorously collected 

throughout the job. However, you should not rely on the accuracy of the 

data unless you are confident that the system is correctly installed and 

that the pilot is using the system correctly. 
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A basic system includes a data recorder and two wires to install the 

flight time switch and the capture switch and an owner’s manual. 

Optional equipment includes one or more data cards, a data card reader, 

a cockpit printer, computer software and a serial cable.  

Figure 1-1 shows the data card system components together with 

optional equipment and load measuring equipment that are used in the 

aircraft. Figure 1-2 shows the optional components that are installed in 

the office. Figure 1-3 shows a laptop attached to the C-30 through the 

serial cable. The data card or the laptop is the link between the aircraft 

and the office. It carries data collected by the data recorder to the data 

card reader and the computer.  

Figure 1-1    The data card system's aircraft-based components 
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 Figure 1-2    The data card system's office-based components 

 
 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Figure 1-3    The laptop attached to the C-30 
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Future Expansion of the C-30  

The C-30 Data Recorder is a powerful cockpit computer with significant 

expansion possibilities. The C-30 is equipped with a CAN Buss capable 

of communicating with up to 256 external devices. These devices could 

be external accelerometers, kneepads, engine sensors, GPS etc.  Our 

expansion efforts are customer driven, please contact our sales 

department for details.  

Figure 1-4    Potential features of the C-30  
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Bill of Materials 

The following items are included with each Data Recording System P/N 

200-257-00. If shortages are found contact the distributor from whom the 

system was purchased. 

P/N DESCRIPTION QUANTITY   

120-089-00 Owner's Manual   1 

210-189-00 C-30 Data Recorder  1 

270-019-00 Capture Switch Wire  1 

270-022-00 Flight Time Switch Wire 1 

 

The following items are optional and are ordered separately.  

 

P/N DESCRIPTION    

475-021-00 Data Card 

210-195-00 Data Card Reader 

210-100-00 C-23 Printer 

100-050-00 C-30 PC Software 

270-099-00 Serial Cable 
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Components 

The following paragraphs describe the major components of the data 

card system and optional equipment. These are the C-30 Data Recorder, 

the C-23 Printer, the Data Card, the Data Card Reader, interface 

software and the serial cable. 

C-30 Data Recorder The C-30 Data Recorder is a programmable microprocessor-based 

device that attaches to an existing connector on the Onboard Systems 

E Series hook-load measuring system in the cockpit. It reads data 

entered by the pilot and monitors the data from the weighing system. A 

two-line by 20-character alphanumeric LCD display shows duration 

information for the current flight, and duration and weight data for the 

current load in pounds or kilograms. Six front panel keys let the pilot 

enter identifying information and change display characteristics. The 

display shows current flight and lift data and can be used as a copilot 

remote indicator. Figure 1-5 shows the C-30 Data Recorder. 

Figure 1-5    C-30 Data Recorder 
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C-23 Printer The C-23 Printer is a compact, easy to use, 24-characters per line 

printer.  It is connected directly to the data recorder, making it possible 

to print reports in the aircraft.  Figure 1-6 shows the C-23 Printer. The 

printer is not intended to be mounted in the aircraft. 

Figure 1-6    C-23 Printer 

Paper Roll

Power ON
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Power Switch

Connector
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Data Card The Data Card is a compact memory device used to retrieve the 

recorded data from the data recorder and transport it to the PC.  

The data card can be erased at any time using the data recorder and 

reused. The memory of the data card is 1MB  (Megabytes). The card 

stores approximately 60,000 entries. Refer to the section, Using the 

Data Card, for more information about the data card. 

Figure 1-7    Data card 
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Data Card Reader The Data Card Reader is a compact device used to receive the Data 

Card and transfer the stored data to the PC. The card reader attaches to 

a PC parallel port. To retrieve lift data from the Data Card, you plug the 

card into the Data Card Reader and use the optional PC software to 

display, print, and save the information. Figure 1-8 shows the data card 

reader. A single data card reader can support many data card systems 

installed in separate aircraft. 

Figure 1-8    Data card reader 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Replacing your Data 

Card Reader’s batteries 

With the label side of the data card reader facing up, gently pry the two 

casing halves apart using a flat head screwdriver.  Lift top casing 

straight up taking care not to catch the casing on the internal pins.   

Remove the old batteries.  The new batteries should be set on the board 

as indicated on the board.  The indicated side should contact the board 

so that plus meets plus and negative meets negative.  

Replace top casing making sure the interior pins are aligned and press 

to close. 

Software Optional PC software, WinHook, for your IBM PC-compatible 

computer prompts the user to display, print, export and save the 

collected data. 
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System Requirements 

The WinHook program is contained on two 3-1/4” diskettes. System 

requirements are as follows: 

 Windows 95 or 98, (NT can be used with the serial port only)   

 486 PC’s and above 

 8 MB RAM minimum 

 5 MB free hard disk space 

 3-1/4” floppy disk drive 

 

Serial Cable  The Serial Cable is used to connect a laptop computer to the C-30. This 

connection allows the transfer of data from the C-30 to the laptop. The 

cable is fitted with a DB-9 connector on one end and a plug on the 

other. Figure 1-9 shows the serial cable.    

 

Figure 1-9    Serial Cable 
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Section 2 

Installing the Data Card System and 

Optional Equipment 

This section describes how to install the components of the Data Card 

System and optional equipment. 

Unpacking Inspection 

After unpacking the components of your data card system, check each 

component against the packing list to ensure that you have received the 

correct items. If you find an error, notify the distributor immediately. 

Inspect the components for evidence of mishandling or damage. All parts 

packaged at the factory were carefully tested, inspected, and packed. If 

damage is evident, do not proceed with installation. Instead, file a claim 

with the carrier and notify the distributor from whom the components 

were purchased. Refer to the Appendix for more information about 

returning a system component. 

Installing the Data Recorder 

 

Follow these steps to install the data recorder in the aircraft cockpit. 

Refer to Figure 2-1, and to Figure 1-1 earlier in this manual. 

 

When the optional C-23 printer is used, the system 

circuit breaker must be rated at 5 amp. 

1. Select an installation location within easy reach of the pilot that 

allows comfortable viewing during flight.  

2. Secure the data recorder to the Dzus rails or another suitable means 

of installation. The data recorder must be solidly mounted parallel 

with the ground, within 5, and facing forward as illustrated in 

Figure 2-1. 
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The Data Recorder contains sensitive 

accelerometers. It is essential that the C-30 be 

installed parallel to the ground within 5 in the 

right and left orientation as illustrated in Figure 

2-1.  

3. The data recorder has two connectors. The connectors are configured 

differently to prevent mismatching them. Connect one to the load 

weigh system's internal harness and the other to the optional C-23 

Printer.  Refer to Figure 1-1 earlier in this manual.  

Figure 2-1    Installing the data recorder 
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Installing User-Supplied Switches 

The flight-time and load-capture switches are used to record the flight 

and to give the pilot control over when a load is recorded. The switches 

are user supplied. 

Installing the  

Flight-Time Switch 

Installation of the flight-time switch is required. The switch allows the 

data recorder to register the beginning and end of each flight. You can 

install the flight-time switch at any available switch, either normally 

open or normally closed, on the helicopter controls or in another 

location that is convenient to the pilot. For a typical installation you 

would install the flight-time switch on the collective so that when the 

pilot pulls up on the collective, the switch opens (or closes) and flight 

time begins counting. A six-foot length of red-coated 24-gauge wire is 

supplied for use in installing the flight-time switch. The wire is 

equipped with a pin connector on one end.  

The flight-time switch can be wired several ways. Use this procedure 

and Figure 2-2 as a guide. Refer back to Figure 1-1 for an overview 

diagram of the switch location in the system.  

1. Disassemble the data recorder connector located in the load weigh 

internal harness by unscrewing it. Notice that each pin socket is 

labeled with a number. 

2. Insert the pin connector of the supplied wire into Pin Socket #4.  

 

Be sure the pin socket is the correct one. Once 

inserted, the pin cannot be removed without the 

use of an extraction tool. 

 

3. Reassemble the data recorder connector. 

4. Cut the free end of the wire to the desired length. 

5. Connect the wire to the selected switch. 

6. Connect the other side of the switch to a good airframe ground. 

7. Using the data recorder's Setup Data menu, set the flight switch menu 

item to the appropriate polarity setting based on flight-time switch 

wiring: Select HIGH if the data recorder is connected to airframe 

ground during flight, select LOW if the data recorder is disconnected 

from airframe ground during flight. 
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Figure 2-2    Flight-time switch wiring guide 

       

     

     Data  

 Airframe Ground   Switch Recorder  
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Installing a Capture 

Switch 

A capture switch gives the data recorder the capability of registering the 

weight of a load at the moment the pilot presses the switch. A capture 

switch is not required; the data recorder automatically takes load 

readings throughout each lift, discards outlying values, and records an 

average weight for the lift. Lifts measured automatically and lifts 

captured with a capture switch can be intermingled. The display and the 

printouts indicate which method of recording was used.  

If a capture switch is desired, you can use any available normally open 

switch on the helicopter controls or any other normally open switch. The 

switch location should be convenient for the pilot to use. A six-foot 

length of purple-coated 24-gauge wire is supplied for use in installing a 

capture switch. The wire is equipped with a pin connector on one end.  

To install the capture switch, use this procedure and Figure 2-3 as a 

guide. Refer back to Figure 1-1 for an overview diagram of the switch 

location in the system. 

1. Disassemble the data recorder connector located in the load weigh 

internal harness by unscrewing it. Notice that each pin socket is 

labeled with a number. 

2. Insert the pin connector of the supplied wire into Pin Socket #2.  

 

Be sure the pin socket is the correct one. Once 

inserted, the pin cannot be removed without the 

use of an extraction tool. 

 

3. Reassemble the data recorder connector. 

4. Cut the free end of the wire to the desired length. 

5. Connect the wire to the selected switch. 

6. Connect the other side of the switch to a good aircraft ground source. 
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Figure 2-3    Capture switch wiring guide 

       

     

     Data  
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Making Electrical Connections 

To connect the data recorder, plug the connector on the data recorder 

into the socket provided on the internal harness of the load weighing 

system.  Refer back to Figure 1-1 for an overview diagram. 

Installing the Data Card Reader 

Follow this procedure to install the Data Card Reader to a personal 

computer.  Refer back to Figure 1-2 and Figure 2-4 for an overview 

diagram. 

 

The card reader is connected to a personal 

computer (PC) parallel port. If a printer is 

connected to the parallel port it is recommended 

that the card reader be attached to a second 

parallel port. Optionally, the use of an A-B Switch 

box could be used so that a printer and the card 

reader share a single port. A-B Switch boxes are 

widely available from computer supply houses. The 

switch should be equipped with DB-25 connectors 

and all 25 pins must be switched. An A-B Switch 

Box is not supplied with the system.  

The card reader can be connected directly to the 

port or for convenience a standard parallel cable 

can be used to locate the card reader in a more 

convenient location. A parallel cable is not 

supplied with the system.    

1. Ensure that the power is off to your computer. 

2. Connect the data card reader to an available parallel port or A-B 

switch.  

3. Turn on your computer. 
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Figure 2-4   The data card installation  

 
 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Figure 2-5    Data Card Reader with an A-B Switch  
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Installing the PC Software 

The PC software allows you to display, print, save and export the 

collected data. 

IBM PC and Compatibles 

The WinHook program is contained on two 3-1/4" diskettes or on one 

CD-ROM. To install WinHook follow these steps. 

1. Insert Disk #1 into your floppy drive or insert CD-ROM into CD 

Drive.  Use Windows Explorer to click on the file Setup.exe.  

2. Follow the instructions on the screen. 

 

Users who are running earlier versions of Windows 

95 may see a box stating that some system 

components need updated before the WinHook 

installation can be completed. When asked if it is 

okay to update the system, click yes and then wait 

for the system to reboot. If the installation window 

does not automatically appear, begin these 

instructions from step 1. 
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Uninstalling the PC Software 

Uninstall WinHook prior to installing a new version or when you would 

like to remove the program from your computer. 

IBM PC and Compatibles 

To uninstall WinHook, follow these steps. 

1. From the Start menu, click Settings and then click on Control Panel. 

2. Double click on Add/Remove Programs. 

3. Scroll down until you locate WinHook and double click on it. 

4. Click yes to confirm the removal of the program. 

 

When WinHook is uninstalled, you may receive an 

error message that states the system was unable to 

remove all WinHook components. This is because 

WinHook creates a configuration file called 

“Onboard.ini” in the WinHook directory and the 

uninstaller program does not remove this file. It 

will not hurt to leave this file on the system. 

 

Even though the WinHook program has been uninstalled, the WinHook 

directory will still remain on your system since that is the default 

location for data files (files with .onb extension). You can delete the 

WinHook directory but keep in mind that if the WinHook directory is 

deleted, all files contained in that directory will also be deleted. 



 

Data Card System Owner's Manual 2-9 

Upgrading the PC Software 

When upgrading the WinHook program, first uninstall the old version by 

following the steps in Uninstalling the PC Software. Once the old 

version has been removed, follow the steps in Installing the PC Software 

to install the new version. 

 

Failure to remove the old version of WinHook 

before installing a new version does not cause 

critical problems, but it will result in duplicate 

Windows Registry entries, making it appear to 

Windows9x as though multiple copies of WinHook 

are installed, when in fact there is only one copy 

installed. 
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Section 3  

Operating the Data Recorder 

This section describes operation of the C-30 Data Recorder. Here are the 

topics in this section. 

 About the Front Panel describes the keys, switches, and display of 

the front panel. 

 Turning on the Data Recorder describes how to power up the data 

recorder. 

 Using the Menus describes the System Menu and gives general 

procedures for operating and accessing its submenus. 

 Entering Setup Data gives detailed procedures and information about 

the values that can be entered using the Setup Data menu. 

 Managing the Customer List describes the procedure for entering up 

to 10 different customers on the Manage Customer List menu. 

 Managing the Location List describes the procedure for entering up 

to 10 different locations on the Manage Location List menu. 

 Entering Company Data describes the procedure for entering 

information on the Company Data menu for inclusion in a report 

header. 

 Using the Utilities Menu describes the screens and procedures 

available using the Utilities menu. 

 Setting the Display describes how to set the display contrast and 

back-lighting to accommodate current lighting conditions and the 

position of the data recorder. 

 Using the Options Menu describes the screens and procedures 

available using the Options menu.  

 Using the Run Screen shows the primary screen used during flight 

operations and describes its displays. 

 Recording a Lift describes the steps to follow when recording a lift. 

 Attention Messages describes messages that can appear on the front 

panel display under certain conditions, which require pilot attention. 
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About the Front Panel 

The front panel of the data recorder includes the following features, as 

shown in Figure 3-1. 

 The 2-line by 20-character liquid crystal display (LCD) shows lift 

data, menu settings, and other information of interest to the pilot.  

 The ENTER key is used to enter new information, select menu 

choices, and change menu settings.  

 The RESET key is used to reset data settings. 

 The Up, Down, Left, and Right arrow keys are used to scroll through 

the menus and change menu settings. 

Figure 3-1    Data recorder front panel 

 

Display 

Serial Port 
RESET Key 

ENTER Key 

Arrow Keys 

Data Card Slot 
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Turning on the Data Recorder 

Engage the Data Recorder circuit breaker to power on the unit. The unit 

does a self-diagnostic routine and then a screen similar to the following 

appears on the display for 5 seconds. It displays the version number, date 

and time. 

C30     V1.14 

7/06/2000     14:26 

A screen similar to the following then appears on the display, this is the 

system’s Run Screen. If, instead, a message appears, refer to Attention 

Messages for more information.  

Load:    0   (    0) 
Flight:000   00:00:00 
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Using the Menus 

The functions of the data recorder are grouped into menus that you use 

to enter and display information.  

 The System Menu accesses the Setup Data, Customer List, Location 

List, Company Data, Utilities and Options menus. Once you enter 

information in these menus, it is retained until you change it. 

 The Setup Data menu contains job identification and setup data that 

are determined by the pilot on-site. Once set, most of the entries, 

such as date, time, pilot and aircraft rarely need to be reset. 

 The Manage Customer List menu allows you to enter up to ten 

different customer names.  Different information can be recorded for 

each customer  

 The Manage Location List menu allows you to enter up to ten 

different locations.  Different information can be recorded for each 

customer. 

 The Company Data menu provides six 20-character lines for the 

entry of your company name and address or other information you 

want printed as a report header.  

 The Utilities menu displays the system version number and allows 

you to erase internal memory and change the display back-lighting 

and contrast. 

 The Options menu contains the optional equipment setup 

information.  

 The Print menu is accessed by pressing ENTER when the Run screen 

is displayed. The menu allows you to specify full report or summary 

format, and to select a particular customer for the report. 

The selections that appear on these menus are described in detail later in 

this section. 

The following paragraphs describe how to: 

 Use the System Menu to access the Setup Data, Customer List, 

Location List, Company Data, Utilities and Options menu. 

 Scroll through a menu 

 Change the value of a menu setting 

 Exit a menu and return to the Run screen 

For detailed information on a particular menu setting, refer to the 

description of that setting later in this section. 
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Accessing Menus with  

the System Menu 

You use the System Menu to access the Setup Data, Customer List, 

Location List, Company Data, Utilities and Options menus. You can 

access the System Menu whenever the Run screen is displayed. To 

access a menu, follow these steps. 

1. From the run screen press the Up and Down keys simultaneously to 

enter the System Menu. 

2. Use the Up or Down keys to select the desired menu name. Figure 3-

2 shows the screens on the System Menu. 

3. Press ENTER to access the selected menu.   

Figure 3-2   System Menu loop 

  

    

      System Menu   

   Enter Setup Data 

    

      System Menu  

 Manage Customer List 

    

      System Menu  

 Manage Location List 

    

      System Menu  

  Enter Company Data 

    

      System Menu  

      Utilities 

    

   System Menu  

Options Menu 

    

       Go to Run 
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Scrolling Through a 

Menu 

To scroll through the selections on a menu without changing any 

settings, press either the Up key or the Down key. The selections on 

each menu are arranged in a continuous loop. 

Changing a Menu 

Selection 

To change the current setting of a particular menu selection, follow  

these steps. 

1. Access the desired menu. 

2. Use the Up or Down keys to scroll through the menu until you see 

the desired selection. 

3. Press the Right or Left key to access entry mode for the menu 

selection. A cursor appears below the first character that you can 

change. 

4. Now enter the desired setting. Use the Left or Right keys to position 

the cursor under the character, number, or setting you want to enter 

or change. Then use the Up or Down keys to scroll through the 

choices. 

 For alphanumeric entries such as aircraft identifier or company 

data, the choices are the characters A-Z, 0-9, space, hyphen, slash, 

apostrophe, and period. 

 For numeric entries such as date or time, the choices are 0-9. 

 For entries that are alternate choices, such as English and Metric, 

you toggle between the choices.  

 Angle brackets are used to show the last choice entered. 

5. When the setting is displayed correctly, press ENTER to enter the 

new setting and return to the current menu. The menu selection that 

follows the selection you just set is displayed. 

 

Exiting a Menu To exit a menu and return to the Run screen, follow these steps. 

1.  Press the Up or Down key to scroll through the menu until the 

following display appears. 

     Go to Run 

 

2.  Press the ENTER key. The Run screen appears. 
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Entering Setup Data 

The Setup Data menu allows you to view and enter setup data and job 

information that are determined or verified by the pilot on-site. Some 

values, such as aircraft and pilot identifiers, help identify the job. Some 

entries, such as time and date, are used by the data recorder to calculate 

data such as length of lift. Other settings, such as operating mode, 

minimum lift load, minimum lift time, flight switch polarity, or units 

setting, are determined by job conditions or the configuration of your 

aircraft or weighing system. 

Setup Data menu entries include these items. 

 Pilot identifier 

 Aircraft identifier 

 Operating mode, either automatic or manual recording  

 Minimum lift load, used during automatic recording 

 Minimum lift time, used during automatic recording 

 Average time 

 Average Start Time 

 Current date 

 Current time 

 Flight switch polarity 

 Units legend, either LB or KG 

 Dampening 

Descriptions of each menu selection appear on the following pages. 
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To access the Setup Data menu from the Run screen, follow these steps. 

1. Press the Up and Down keys simultaneously to access the System 

Menu.  

2. Use the Up or Down keys to display the "Enter Setup Data" selection. 

   System Menu  

  Enter Setup Data 

3. Press ENTER. You can now scroll through the selections in the 

Setup Data menu loop shown in Figure 3-3. 

Figure 3-3    Setup Data menu loop 

 

     

     

    Setup Data 

Pilot:   J JENSEN  

   Setup Data  

Date: 05/28/00     

     

    Setup Data  

Aircraft:N12345678 

   Setup Data  

Time: 13:42:58     

     

    Setup Data  

Op Mode:<AUTO>  

   Setup Data  

Flt Switch:<High>  

     

    Setup Data  

Min Lift Load:0400 

   Setup Data  

Units:<LB>         

     

    Setup Data  

Min Lift Time:015  

   Setup Data  

Damping: <3>       

     

    Setup Data  

Average Time:00    

 Go To System Menu 

 

     

    Setup Data  

Avg Start Time:00  

Go To Run 

 

     

     

     



 

Data Card System Owner's Manual 3-9 

 

Entering Pilot Identifier The pilot identifier serves to connect a particular pilot to the job 

information stored in the data card and printed in the reports. A change 

of pilots during a job is noted on the reports. The identifier can be any 

alphanumeric string up to nine characters long. 

To enter the pilot identifier, follow these steps.  

1. Scroll through the Setup Data menu until you see a screen like this. 

   Setup Data 

Pilot:   J JENSEN  

2. Press the Right or Left key to place a cursor under the first character 

that can be changed. 

    Setup Data  

Pilot:   J JENSEN  

3. Use the Right or Left keys to position the cursor under each character 

you want to change, and then use the Up or Down keys to scroll 

through the choices for that character. For example, you might enter 

this value. 

     Setup Data 

Pilot:K HILLEN   _ 

4. When all changes have been made, press ENTER to save the new 

setting and move to the next menu selection. 

5. If you are finished making changes in the Setup Data menu, use the 

Up or Down key to scroll to the Go To System Menu selection or the 

Go To Run selection. Press ENTER to display the selected screen. 
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Entering Aircraft 

Identifier 

The aircraft identifier serves to connect a particular aircraft to the job 

data stored in the data card and printed in the reports. Depending on 

your need, the identifier might be the aircraft's tail number or serial 

number, or any other alphanumeric string up to nine characters long. 

To enter the aircraft identifier, follow these steps.  

1. Scroll through the Setup Data menu until you see a screen like this. 

   Setup Data  

Aircraft:N12345678 

2. Press the Right or Left key to place a cursor under the first character 

that can be changed. 

    Setup Data  

Aircraft:N12345678 

3. Use the Right or Left keys to position the cursor under each character 

you want to change, and then use the Up or Down keys to scroll 

through the choices for that character. For example, you might enter 

this value. 

     Setup Data 

Aircraft:N87654321 

4. When all changes have been made, press ENTER to save the new 

setting and move to the next menu selection. 

5. If you are finished making changes in the Setup Data menu, use the 

Up or Down key to scroll to the Go To System Menu selection or the 

Go To Run selection. Press ENTER to display the selected screen. 
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Setting Recording Mode The recording mode setting allows you to select between automatic and 

manual recording modes. In automatic mode, the system automatically 

records any lift that exceeds both the minimum load and minimum lift 

time set. In manual mode, the system records the lift only when the 

pilot presses the capture switch. 

If manual mode is set, the minimum lift load and minimum lift time 

information is not needed. 

To set the system for automatic or manual recording, follow these steps. 

1. Scroll through the Setup Data menu until you see an item like this. 

   Setup Data  

Op Mode:<AUTO>   

 The angle brackets around the word "AUTO" indicate that in this 

example the current setting is for automatic recording. 

2. Press the Right or Left key to access the following screen.  

     Setup Data   

Set Mode:MANUAL  

3. Use the Right or Left key to toggle between the choices until the 

desired selection is displayed. 

4. Press ENTER to save the new setting and move to the next menu 

selection. 

5. If you are finished making changes in the Setup Data menu, use the 

Up or Down key to scroll to the Go To System Menu selection or the 

Go To Run selection. Press ENTER to display the selected screen. 
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Setting Minimum  

Lift Load 

The minimum lift load setting allows you to specify the minimum 

weight that determines a valid load. Defining a minimum load prevents 

the system from recording every small load that is applied to the hook. 

The minimum lift load setting can be any number up to four digits long, 

to a maximum of 9999. There is no scale in this function, entering 0400 

means 400 LBs or KGs.  The units legend (LB or KG) depends on the 

units setting. Refer to Setting the Units Legend later in this section. 

If manual recording mode is set, this information is not needed. 

To change the minimum lift load, follow these steps.  

1. Scroll through the Setup Data menu until you see an item like this. 

   Setup Data  

Min Lift Load:0400 

2. Press the Right or Left key to access the following screen. A cursor 

appears under the first digit. The display also indicates the units 

setting that is in effect. 

     Setup Data   

Min Load (LB):0400 

3. Use the Right or Left keys to position the cursor under each digit you 

want to change, and then use the Up or Down keys to scroll through 

the setting choices for that digit. 

     Setup Data   

Min Load (LB):0250 

4. When all changes have been made, press ENTER to save the new 

setting and move to the next menu item. 

5. If you are finished making changes in the Setup Data menu, use the 

Up or Down key to scroll to the Go To System Menu selection or the 

Go To Run selection. Press ENTER to display the selected screen. 
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Setting Minimum  

Lift Time 

The minimum lift time setting allows you to specify the length of time 

in seconds that a load must be carried to be recorded as a valid load. 

Defining a minimum time prevents the system from recording a quick 

tug on the hook as a valid load. The minimum lift time setting can be 

any integer up to three digits long, to a maximum of 999 seconds.  

If manual recording mode is set, this menu item does not appear. 

To change the minimum lift time, follow these steps.  

1. Scroll through the Setup Data menu until you see an item like this. 

   Setup Data  

Min Lift Time:015  

 This example indicates a minimum lift time of fifteen seconds. 

2. Press the Right or Left key to access the following screen. A cursor 

appears under the first digit.  

     Setup Data   

Min Time (sec):015 

3. Use the Right or Left key to position the cursor under each digit you 

want to change, and then use the Up or Down keys to scroll through 

the setting choices for that digit. 

     Setup Data   

Min Time (sec):010 

4. When all changes have been made, press ENTER to save the new 

setting. 

5. If you are finished making changes in the Setup Data menu, use the 

Up or Down key to scroll to the Go To System Menu selection or the 

Go To Run selection.  Press ENTER to display the selected screen. 
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Setting the Average 

Time 

The average time sets the length of time that the load is averaged during 

a lift. The average time setting can be any number up to two digits long, 

to a maximum of 99 seconds. If the average time is zero, the load is 

averaged from the time the load exceeds the minimum lift time and lift 

load until the load is reduced by 75%.  

If the system is set for manual mode this setting is not required.   

 

To change the average time setting, follow these steps.  

1. Scroll through the Setup Data menu until you see the average time  

entry. The time reads in seconds. 

   Setup Data  

Average Time:00    

2. Press the Right or Left key to place a cursor under the first character 

that can be changed. 

     Setup Data 

Avg Time (sec):00  

3. Use the Right or Left key to position the cursor under each digit you 

want to change, and then use the Up or Down keys to scroll through 

the choices for that digit. 

     Setup Data 

Avg Time (sec):45  

4. When all changes have been made, press ENTER to save the new 

setting and move to the next menu selection. 

5. If you are finished making changes in the Setup Data menu, use the 

Up or Down key to scroll to the Go To System Menu selection or the 

Go To Run selection. Press ENTER to display the selected screen. 
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Setting the Average 

Start Time 

The average start time is the time after a lift has exceeded the minimum 

start time and minimum lift load and before the average time begins. 

The average start time setting can be any number up to two digits long, 

to a maximum of 99 seconds. If the average start time is zero, the 

average time begins when the load exceeds the minimum lift time and 

lift load.  

If the system is set for manual mode this setting is not required.  

 

To change the average start time setting, follow these steps.  

1. Scroll through the Setup Data menu until you see the average start 

time entry. The time reads in seconds. 

   Setup Data  

Avg Start Time:00  

2. Press the Right or Left key to place a cursor under the first character 

that can be changed. 

Setup Data 

Start Time(sec):00 

3. Use the Right or Left key to position the cursor under each digit you 

want to change, and then use the Up or Down keys to scroll through 

the choices for that digit. 

Setup Data 

Start Time(sec):45 

4. When all changes have been made, press ENTER to save the new 

setting and move to the next menu selection. 

5. If you are finished making changes in the Setup Data menu, use the 

Up or Down key to scroll to the Go To System Menu selection or the 

Go To Run selection.  Press ENTER to display the selected screen. 
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Entering the Date The date setting helps identify job data and is printed on the job report. 

The date is updated by the data recorder clock, which is powered by an 

internal lithium battery. Once set, the correct date should remain in the 

system as long as the battery is good.  

Check the data occasionally to ensure that it is correct. For information 

on the battery, read C-30 Internal Battery at the end of this section. 

To change the date setting, follow these steps.  

1. Scroll through the Setup Data menu until you see the date entry. The 

format of the date is MM/DD/YY. 

   Setup Data  

Date: 05/28/00    

2. Press the Right or Left key to place a cursor under the first character 

that can be changed. 

     Setup Data 

Set Date: 05/28/00 

3. Use the Right or Left keys to position the cursor under each digit you 

want to change, and then use the Up or Down keys to scroll through 

the choices for that digit. 

     Setup Data 

Set Date: 05/29/00 

4. When all changes have been made, press ENTER to save the new 

setting and move to the next menu selection. 

5. If you are finished making changes in the Setup Data menu, use the 

Up or Down key to scroll to the Go To System Menu selection or the 

Go To Run selection. Press ENTER to display the selected screen. 
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Entering the Time The time setting is used to identify the job data. The start time and 

duration of each lift is printed in the reports. The time is controlled by 

the data recorder clock. Once set, the correct time should remain in the 

system as long as the battery is good.  

Check the time occasionally to ensure that it is correct. For information 

on the battery, read C-30 Internal Battery at the end of this section. 

To change the time setting, follow these steps.  

1. Scroll through the Setup Data menu until you see the time entry. The 

format of the time display is HH:MM:SS using a 24-hour clock. 

   Setup Data  

Time: 13:42:58     

2. Press the Right or Left key to place a cursor under the first character 

that can be changed. 

     Setup Data 

Set Time: 13:42:58 

3. Use the Right or Left keys to position the cursor under each digit you 

want to change then use the Up or Down keys to scroll through the 

choices for that digit. 

     Setup Data 

Set Time: 14:35:00 

4. When all changes have been made, press ENTER to save the new 

setting and move to the next menu selection. 

5. If you are finished making changes in the Setup Data menu, use the 

Up or Down key to scroll to the Go To System Menu selection or the 

Go To Run selection.  Press ENTER to display the selected screen. 
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Specifying Flight-Time 

Switch Polarity 

You set flight-time switch polarity to specify the type of connection 

used by the flight-time switch wiring. The correct setting depends on 

how this user-supplied switch is installed. There are two menu settings: 

High specifies that the switch connects the data recorder to an airframe 

ground source during flight; Low specifies that the switch disconnects 

the data recorder from airframe ground during flight. 

Follow these steps to specify the flight-time switch polarity. 

1. Scroll through the Setup Data menu until you see an item like this. 

   Setup Data  

Flt Switch:<HIGH>  

 The angle brackets around the High selection in this example indicate 

that when the aircraft is in flight, the flight-time wire of the data 

recorder is connected by the switch to airframe ground. When the 

aircraft is on the ground, the switch disconnects the wire from 

airframe ground.  

2. Press the Right or Left key to access the following screen.  

     Setup Data   

Polarity:LOW      

3. Use the Right or Left key to toggle between High and Low until the 

desired selection is displayed. Select Low if the flight time counts 

when the flight-time wire is disconnected from airframe ground. 

4. Press ENTER to save the new setting and move to the next menu 

item. 

5. If you are finished making changes in the Setup Data menu, use the 

Up or Down key to scroll to the Go To System Menu selection or the 

Go To Run selection.  Press ENTER to display the selected screen. 
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Setting the Units Legend The units legend setting allows you to set the data recorder screens and 

report printouts to list values using either pounds (LB) or kilograms 

(KG). The data recorder should be set to match the output of your C-39 

indicator. The C-39 indicator's output scale can be changed by the 

operator.  

Follow these steps to set the units of measurement display. 

1. Scroll through the Setup Data menu until you see this item. 

   Setup Data  

Units:<LB>      

 The angle brackets around the legend "LB" in this example indicate 

that load weight measurements will display the legend in pounds. 

2. Press the Right or Left key to access the following screen.  

     Setup Data    

Set Units:KG    

3. Use the Right or Left key to toggle between the LB and KG until the 

desired selection is displayed. 

4. Press ENTER to save the new setting and move to the next menu 

item. 

5. If you are finished making changes in the Setup Data menu, use the 

Up or Down key to scroll to the Go To System Menu selection or the 

Go To Run selection. Press ENTER to display the selected screen. 
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Setting Dampening Dampening is a software routine, located in the C-39 that averages the 

peaks and valleys before the load reading is displayed to the pilot. This 

makes the display more stable. The C-39 dampening level is pilot 

selectable from 1–9. The higher the number the more the load is 

dampened.  

It is necessary to set the C-30 dampening to the same level as it is in the 

C-39. Later models of the C-39 transfer this information automatically. 

If you have a C-39 indicator with version numbers of 21 or higher it is 

not necessary to set the dampening level in the C-30.  

To enter the dampening menu, follow these steps. 

1. Scroll through the Setup Data menu until you see an item like this:  

  Setup Data   

Damping: <3>   

2. Press the Right or Left key to access the following screen. 

 

Setup Data   

Damping: 3   

 

3. Use the Up or Down key to change the dampening setting until the 

desired selection is displayed. 

 

4. When all changes have been made, press ENTER to save the new 

setting and move to the next menu item. 

 

5. If you are finished making changes in the Setup Data menu, use the 

Up or Down key to scroll to the Go To System Menu selection or the 

Go To Run selection. Press ENTER to display the selected screen. 
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Managing the Customer List 

The customer list links job data to a particular customer. When work is 

performed for several customers, a separate job report can be generated 

for each customer. The customer names can be any alphanumeric string 

up to nine characters long. Up to ten customers can be entered and this 

information will be stored until it is changed. 

To enter or edit customer names, follow these steps.  

1. Scroll through the System Menu until you see this screen: 

   System Menu 

Manage Customer List 

2. Press ENTER and use the Up or Down arrow key to scroll to the 

customer that needs to be changed or added. 

3. Press the Right or Left key to place a cursor under the first character 

that can be changed. 

   Customer # 4         

 _BILL      

4. Use the Right or Left key to position the cursor under each character 

you want to change, and then use the Up or Down keys to scroll 

through the choices for that character. For example, you might enter 

this value. 

   Customer # 4                                                       

 JERRY    

5. When all changes have been made, press ENTER to save the new 

setting and then use the Up or Down key to scroll to the next 

customer. 

6. If you are finished making changes in the Customer List menu, select 

the desired customer by using the Up or Down arrow key until the 

correct customer appears and then press ENTER to get back to the 

System Menu. 
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Be sure that when you exit out of the Manage 

Customer List menu, the correct customer has 

been selected.  The flight information will be 

recorded for the customer last selected.  To verify 

customer or change to another customer, follow 

the procedures on the following page. 

To access the Customer List menu from the Run screen, follow these 

steps. 

1. If accessing during flight, press the Up or Down arrow key to end 

the turn. 

If the turn is not ended and a new customer is selected, the last lift will 

be added to the new customer.  Press the Up or Down key to end the 

turn. 

2. Press the Up and Down arrow keys simultaneously to access the 

System Menu.  You should see Manage Customer List on the screen, 

press ENTER. 

3.  Follow the guidelines on the previous page to select, add or change 

customers. 
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Managing the Location List 

The location list helps to further describe work done for a particular 

customer on the job report. The locations can be changed at any time 

between lifts, and the lifts corresponding to each location are indicated 

on the report. The locations can be any alphanumeric string up to nine 

characters long.  Up to ten different locations can be entered and will 

remain stored until they are changed. 

To enter or edit locations, follow these steps.  

1. Scroll through the System menu until you see this screen: 

   System Menu 

Manage Location List 

2. Press ENTER and use the Up or Down arrow keys to scroll to the 

location that needs to be changed or added. 

3. Press the Right or Left key to place a cursor under the first character 

that can be changed. 

    Location # 3  

                 

4. Use the Right or Left keys to position the cursor under each character 

you want to change, and then use the Up or Down keys to scroll 

through the choices for that character. For example, you might enter 

this value. 

     Location # 3        

 Vancouver     

5. When all changes have been made, press ENTER to save the new 

setting and then use the Up or Down arrow keys to scroll to the next 

location. 

6. If you are finished making changes in the Location List menu, select 

the desired location by using the Up or Down arrow keys until the 

correct location appears and then press ENTER to get back to the 

System Menu. 
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Be sure that when you exit out of the Manage 

Location List menu, the correct location has been 

selected.  The flight information will be recorded 

for the location last selected.  To verify location 

or change to another location, follow the 

procedures on the following page. 

To access the Location List menu from the Run screen, follow these 

steps. 

1. If accessing during flight, press the Up or Down arrow key to end 

the turn. 

If the turn is not ended and a new location is selected, the last lift will be 

added to the new location.  Press the Up or Down key to end the turn. 

2. Press the Up and Down arrow keys simultaneously to access the 

System Menu.  Use the Up or Down arrow keys to scroll to Manage 

Location List and then press ENTER.   

3. Follow the guidelines on the previous page to add or change 

locations. 
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Entering Company Data 

The Company Data menu allows you to enter standard information about 

your company, such as name, address, and phone number. This 

information is printed in the header at the top of all reports. Six lines of 

20 characters each are available. Entering data on these lines is optional.  

To access the Company Data menu from the Run screen, follow these 

steps. 

1. Press the Up and Down keys simultaneously to access the System 

Menu.  

2. Use the Up or Down keys to display the Company Data selection. 

   System Menu  

 Enter Company Data 

3. Press ENTER. You can now scroll through the lines in the Company 

Data menu loop. Figure 3-4 shows the Company Data menu loop 

with example entries for the fictional company Rotor-to-Order. 

To enter company data, follow these steps.  

1. Access the Company Data menu as described above. A display like 

this appears. 

 Company line:1  

 

2. Press the Right or Left key to access the following screen. A cursor 

appears in the first position on the second line of the display. 

Enter Company line:1 

  

3. Use the Up or Down keys to scroll through the character choices — 

A-Z, 0-9, space, hyphen, slash, apostrophe, and period. When the 

desired character is displayed, use the Right or Left keys to place the 

cursor under the next position where you want to change or enter a 

character. 

4. When all changes have been made to the first line of company data, 

press ENTER to save the new setting and move to the next line. 

5. Edit Lines 2 through 6 as you did for Line 1.  

6. When you are finished, return to the System Menu or the Run screen 

by pressing ENTER when the appropriate choice is displayed. 
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Figure 3-4    Company Data menu loop 

  

    

    Company line:1  

   ROTOR-TO-ORDER 

    

    Company line:2  

 HELICOPTER SUPPORT 

    

   Company line:3   

13915 NW 3rd Court 

    

    Company line:4  

 VANCOUVER WA 98685 

    

    Company line:5  

 PHONE  360-546-3072 

    

    Company line:6  

 FAX    360-546-3073 

    

   Go to System Menu 

 

    

       Go to Run 
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Using the Utilities Menu 

The Utilities menu displays the system version number and allows you 

to adjust the display contrast, adjust the display backlight and erase a 

data card. 

To access the Utilities menu from the Run screen, follow these steps. 

1. Press the Up and Down keys simultaneously to access the System 

Menu.  

2. Use the Up or Down keys to display the Utilities selection. 

   System Menu  

     Utilities 

3. Press ENTER. You can now scroll through the lines in the Utilities 

menu loop, shown in the example in Figure 3-5. 

Figure 3-5    Utilities menu loop 

  

    

    

  Onboard  Systems  

 Data Recorder V 1.14 

    

  Change Contrast  

   

    

  Change Backlight  

   

    

    Erase Memory   

Press RESET to Clear 

    

   Go to System Menu 

     

    

       Go to Run    
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Viewing the Software 

Version Number 

The first screen in the Utilities menu displays the version number of the 

data recorder software. 

To view the version number, follow these steps. 

1. Scroll through the Utilities menu until you see a screen similar to this 

example. 

Onboard Systems  

Data Recorder V 1.14 

2. Press the Down key to move to the next menu screen, or press the Up 

key to get the Go to Run screen. 

 

 

Adjusting the  

Display Contrast 

The data recorder display is equipped with adjustable contrast control. 

Setting the contrast adjusts the display to help compensate for different 

viewing angles. 

To change the contrast setting, follow these steps. 

1. Go to the Change Contrast menu in the Utilities menu loop.  

2. Press the ENTER key to enter the change menu. The display should 

look like this. 

Change Contrast 

********** --------- 

3. Use the Right or the Left arrow keys to change the contrast.   

4. Press the ENTER key when the desired contrast is achieved.  
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Adjusting the  

Back-Lighting 

The data recorder display includes an electroluminescent back-lighting 

feature. Back-lighting helps compensate for different ambient lighting 

conditions. 

To change the intensity of the back-lighting, follow these steps. 

1. Go to the Change Backlight menu in the Utilities menu loop.  

2. Press the ENTER key to enter the change menu. The display should 

look like this.      

Change Backlight 

********** --------- 

3. Hold down the Right arrow key to increase the backlight intensity.  

4. Hold down the Left arrow key to reduce the intensity.  

5. Press the ENTER key when the desired intensity is achieved.  

 

Erasing Memory The data recorders internal memory stores all of the accumulated flight 

and lift information. Once the data is retrieved by a data card or laptop, 

the data recorder’s internal memory should be erased. 

To erase the internal memory of the data recorder, follow these steps. 

1. Go to the Erase Memory menu in the Utilities menu loop.  

2. Press the RESET key to enter the Erase Memory menu. The display 

should look like this. 

Erase Current Data?  

Enter to confirm 

3. Press the ENTER key to erase the internal memory. The display 

should look like this.   

Formatting Memory  

********** --------- 

4. Press the RESET key to escape out of the Erase Memory menu and 

return to the Utilities menu. 
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Using the Options Menu 

The Options menu allows you to enable and disable installed options.  

Options menu entries include these items. 

 Internal Accelerometer  

 External Accelerometer 

 Kneepad  

To access the Options menu from the Run screen, follow these steps. 

1. Press the Up and Down keys simultaneously to access the System 

Menu.  

2. Use the Up or Down keys to display the "Options" selection. 

 System Menu  

Options Menu 

3. Press ENTER. You can now scroll through the selections in the 

Options menu loop shown in Figure 3-6. 

Figure 3-6    Options menu loop 

  

    

    

  Options Menu   

Int. Accelerometer 

    

  Options Menu   

Ext. Accelerometer 

    

    Options Menu    

Kneepad 

    

  Go to System Menu 

 

    

       Go to Run    
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Internal Accelerometer The data recorder is equipped with internal accelerometers. They are 

used to determine the optimum time for the data recorder to record a 

lift, when the system is set to Auto mode. Refer to the Setting the 

Recording Mode section. This feature is not affected by enabling or 

disabling the accelerometers. 

The internal accelerometers are also used to correct the recorded lift 

weight for the effect of acceleration. This feature is turned off when the 

internal accelerometers are disabled. 

 

To access the Internal Accelerometer menu from the Options screen, 

follow these steps. 

1. Scroll through the Options menu until you see this screen:  

  Options Menu   

Int. Accelerometer 

2. Press ENTER. You can now scroll through the selections in the 

Internal Accelerometer menu loop shown in Figure 3-7. 

Figure 3-7    Internal Accelerometer menu loop 

  

    

    

  IntAccelerometer  

Status: <Enabled>  

    

  IntAccelerometer     

Return to Options 
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Status The internal accelerometers can be turned on or off at the status menu. 

 

To enter the status menu, follow these steps. 

1. Scroll through the Internal Accelerometer menu until you see an item 

like this:  

 IntAccelerometer 

Status: <Enabled>   

2. Press the Right or Left key to access the following screen. 

 

 IntAccelerometer 

Status: Disabled   

 

3. Use the Right or Left key to toggle between enabled and disabled.  

 

4. When all changes have been made, press ENTER to save the new 

setting and move to the next menu selection. 

 

5. If you are finished making changes in the Internal Accelerometer 

menu, use the Up or Down key to scroll to the Return to Options 

Menu selection. Press ENTER to display the selected screen. 
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Using the Run Screen 

The Run screen is the screen that appears when you turn on the data 

recorder. It is displayed during normal operation. The Run screen must 

be displayed to record lift data. If a screen other than the Run screen 

appears on power up, refer to Attention Messages at the end of this 

section for more information.  

Several types of information can be displayed on the Run screen, as 

described in the following paragraphs. 

During a Lift Figure 3-8 shows an example of the Run screen as it appears during lift 

operations. The first line of the Run screen shows the weight of the 

load, the flight status indicator, and any load weight captured using the 

optional capture switch. The flight status indicator appears as follows: 

 Ground indicator. The flight has not yet begun, or the flight has 

ended. 

 Flight indicator. The aircraft is in flight but is not performing a lift. 

Flight time is accruing. 

 Lift indicator. A load is being carried. Turn time and flight time are 

accruing. The indicator and lift information appear when lift load and 

time minimums are met.  

 Turn indicator. The load has been dropped and the aircraft is 

returning for another load. Turn time and flight time are accruing. 

Turn time is the time from the beginning of one lift to the beginning 

of the next lift. 

Figure 3-8    Run screen with lift information 

 Current load   

   

   Flight status indicator 

    Recorded load 

      

 Load:1252    [1250] 

Lift:0014   00:01:02 
 

— Load information 

— Lift number and lift clock 

    

  Clock 

 Current Lift 
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Viewing Customer  

Totals 

You can also use the Run screen to display flight and lift totals for a 

particular customer. This feature allows you to display summary 

customer data in the cockpit. Two screens of customer information are 

available; one shows the number of flights and total flight time, the 

other shows the number of lifts and total load. 

To view the customer totals: 

1. If needed, use the Manage Customer List menu to set the customer 

identifier to the name of the customer whose data you want to view. 

2. Return to the Run screen, then press the Right or Left key one or 

more times until the desired data is displayed.  

 

If you begin a lift when a customer totals screen is 

displayed, the lift data Run screen automatically 

appears. The current customer identifier setting is 

used to identify the lift. 

Figure 3-9 shows examples of Run screens with customer totals.  

Figure 3-9    Run screens with customer totals 

    

    Johnson Totals 

Flight:0005 04:12:38 
 

 

— Total # of flights and total flight time 

  

    

    Johnson Totals 

Lift:0037      18563 
 

 

— Total # of lifts and total load 
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How Lifts Are Recorded  
 

Determining When a Lift is Recorded 

 
The system uses two methods to determine when a lift is recorded, 

manual and automatic. The setup menu is used to select between 

automatic and manual. See sections Setting Recording Mode.  

Manual Method  

The pilot can use the capture switch at any time during a lift to record a 

lift manually. The captured weight is not averaged, it is the weight of the 

load at that moment. If the capture switch is again activated the first 

record is replaced by the new captured weight, only the last record is 

kept. The capture switch can also be used when the system is in the 

automatic recording mode. Activating the capture switch will overwrite 

lifts recorded automatically. If the system is in the manual recording 

mode and the capture switch is not activated during the lift, no record of 

the lift will be made. The PC report will list how the lift was recorded, 

automatic or manual.   

Automatic Method  

The automatic method uses the minimum lift load and the minimum lift 

time settings. When the weight of the load exceeds the weight entered 

into the minimum lift load and the load is carried for a period of time 

that exceeds the time entered into the minimum lift time the lift is 

recorded. 

 

Determining the Weight of a Lift 
 

The system uses two methods to determine the weight of a load. One is 

manual and another is average.  

Manual Method  

At any time during a lift the pilot can use the manual switch to capture a 

lift. The captured weight is the weight of the load at that moment. If the 

internal accelerometers are enabled the captured weight will be corrected 

for acceleration and the report note will be <cap><acc>. If the internal 

accelerometers are disabled the captured weight will be the uncorrected 

weight and the report note will be <cap><std>. The capture switch 

overwrites any automatic records. The manual switch can be used 

repeatedly during a lift, only the last capture is recorded.  
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Automatic Method  

The automatic method uses the setting in the average time and average 

start time. When the average time clock begins the system repeatedly 

computes the standard deviation for both the accelerometer corrected 

and uncorrected weights and the standard deviation with the lowest 

value is used as the weight of the load.  

 

If the internal accelerometers are enabled and the standard deviation for 

the accelerometer corrected weight is the lowest the report will show 

(acc) to indicate the recording method. If the standard deviation for the 

uncorrected weight is the lowest the report will show (std). If the internal 

accelerometers are disabled the recorded weight will be the uncorrected 

weight and the report note will be <std>. 

 

If the load is dropped before the average time has expired, the 

computations are done over the time the data was gathered. If the load is 

dropped before minimum lift time has expired or minimum weight value 

met, no lift is reported.  

 

Improving the Accuracy of Lifts Recorded Automatically   
 

The accuracy of the recorded load can be optimized by understanding 

how the system records the weight. Illustrated below is a graphical 

representation of a lift profile. It shows the load being picked up and 

carried for a period of time before being set down. It’s not particularly 

realistic as the initial vertical acceleration and drag are not shown.  

 

Figure 3-10  Load Profile  

 

 



 

Data Card System Owner's Manual 3-37 

A somewhat more accurate, though exaggerated for illustration 

purposes, is the load profile in Figure 3-11. This shows the initial 

vertical acceleration and the increase in airframe load due to drag. Not 

illustrated in this figure is the initial jerking that may be present and the 

bounce that may occur after transition.  

 

Figure 3-11  Exaggerated Load Profile 

 

No two load profiles are the same but, with an understanding of their 

common elements such as initial acceleration, bounce, drag and time and 

an understanding of the previous section, fairly accurate records are 

possible.  

 

Putting it all together a typical automatic setup, with the internal 

accelerometers enabled, might look like this.  

 

Figure 3-12  Typical Automatic Setup   

 

Note that the average time includes the initial jerking that may be 

present as the load clears the ground. The internal accelerometers should 

take care of the initial acceleration bump and the average time ends prior 

to the introduction of significant drag.  
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A longer average time could be used to gain more accuracy if the load 

did not introduce significant drag.  

 

If the internal accelerometers are disabled the system calculates the 

standard deviation for the uncorrected weight only. For the optimum 

accuracy the average start time should be moved out to miss the initial 

acceleration bump as illustrated in Figure 3-13.  

 

Figure 3-13  Increasing average start time 
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Recording a Flight and Lift 

This procedure describes the steps you follow to record a flight and lift 

data. See fig 3-14. 

1. Turn on the power to the weighing system and the data recorder. 

2. Use the Setup Data and Company Data menus to change any menu 

settings, as needed. 

3. Ensure that the Run screen or one of the customer total screens is 

displayed. See Figure 3-14a. 

Load:    0  (     0)     

Flight:000   00:00:00 

4. The zero button on the weighing system indicator can be used to zero 

the load readings on both the indicator and the data recorder. See C-

39 operation for tare weights.  

 

You can use the data recorder as a remote 

indicator.  

5. Begin the flight. The flight counter starts and the ground indicator  

changes to the flight indicator . See Figure 3-14b. 

Load:    0   (    0)     

Flight:001   00:00:01 

6. Begin a lift. When both the minimum lift time and minimum lift load 

are met, the system records a lift. On the Run screen, the load weight 

registers and the lift indicator  appears. The lift data line appears, 

the lift counter increments, and the lift clock begins counting. See 

Figure 3-14c.  

 The system displays and records the full duration of the lift, even if a 

minimum lift time is set. For example, if the minimum lift time is 

five seconds, the display looks something like this when the lift 

indicator first appears. 

Load:1251   <1251>       

Lift:0001   00:00:05 
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 During manual operations, the pilot must press the capture switch to 

begin recording a lift. During automatic operations, if the pilot 

presses the capture switch at any time during the lift, the data 

recorder captures the weight of the load that is measured at the 

moment the switch is pressed and applies that weight to the entire 

lift. See Figure 3-14d. The measurement can be recaptured at any 

time during the lift; only the last value is saved. The captured load 

weight appears next to the current load display.  

Load:1250    [1250] 

Lift:0001  00:01:02 

 If a capture switch is not used during automatic recording, the 

average weight of the load during the lift is recorded. 

7. For both automatic and manual recording, flight information and the 

turn indicator  appear when the load is reduced by 75%.  

Load: 312   [1250]       

Flight:001  00:04:13 

 For example, if the load weighs 1000 pounds, lift timing ends when 

the system registers 250 pounds. Turn time accrues until the next 

load is picked up or the flight ends. See Figure 3-14e.  

8. Repeat Step 7 for all the lifts you want to record on this flight.  

9. Landing the aircraft ends the current flight. There is a 20-second 

delay before the ground indicator appears. 

 Changing new customer information ends the current flight and 

begins a new flight.  This can be done at any time during a flight. 
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Figure 3-14    Recording a lift 

 No load on hook (a) Before a flight 

   

   Ground indicator 
     

 Load:    0  <    0>      
Flight:000  00:00:00 

 

    

  Flight clock 

 Flight number 

 No load on hook (b) Beginning a flight 

   Flight indicator 
     

 Load:    0  <    0>      

Flight:001  00:01:10 
 

    

  Flight clock counts 

 Flight number increments 

 Current load (c) Beginning a lift, minimums exceeded 

   Lift indicator 
     

 Load:1251    {1251}       

Lift:0001   00:00:04 
 

    

  Lift clock appears when minimum time exceeded 

 Lift number within flight 

   (d) Capturing a load 

Current load (optional) 

   Lift indicator 

    Captured load 
      

 Load:1250    [1250] 

Lift:0001   00:01:02 

 

 Load returns to zero (e) Dropping a load 

   Turn indicator 
     

 Load:   0    [1250]       

Lift:0001   00:01:02 
 

  

 Ground indicator appears and (f) Ending a flight 

clock stops after 20-second delay 
     

 Load:   0    [1250]     

Flight:001  00:04:45 
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C-30 Internal Battery 

When the data recorder is turned on, it is powered by the aircraft 

electrical system. When the data recorder is turned off or is 

disconnected, its internal memory and clock are maintained by a lithium 

battery inside the data recorder. The projected battery life is 10 years. 

The indication that the battery life is at its end is inconsistent clock and 

date readings. 

The unit should be returned to the factory for battery replacement.  

Attention Messages 

The data recorder displays certain messages when an action other than 

normal operation is required. 

System Conditions 

System condition messages indicate a situation with data card system 

hardware that requires pilot attention.  

 

 No data from hook 

Flight:  1  00:00:10 

The data card system is not receiving information from the C-39 

indicator. There are four possible causes for this condition. 

1. The load cell is not connected to the internal wiring harness. 

2. There is no power to the indicator, but there is power going to the 

data recorder. 

3. The C-39 indicator is in some mode other than run. 

4. The transmitting circuits in the C-39 indicator are defective. The 

indicator and data recorder should be returned to the factory for 

inspection and service. 

Memory is >80% full 

   Copy to a Card  

The system memory is nearing its memory capacity. The data must be 

down loaded or it will be overwritten by new data when it reaches 100% 

capacity. Save the data by connecting a PC to the serial port or inserting 

a data card.  
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Section 4  

Operating the Printer 
 

This section describes operation of the optional C-23 Printer. Here are 

the topics in this section. 

 Turning on the Printer  

 Printing a Self Test  

 Installing the Paper  

 Installing Cartridge Ribbon  

 Clearing a Paper Jam  

 Printing a Report  

 Reading a Report  
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Turning on the Printer The C-23 Printer should be turned on after the load weigh system is 

powered up.  The power switch has three positions.  The OFF position 

is all the way to the left, the ON position is in the center, and the 

PAPER FEED position is all the way to the right.  To turn the printer 

on, follow these steps.   

1. Turn on the printer by pushing the POWER switch down on the right 

side.  Now release the switch and it will remain in the center ON 

position. 

2. The power LED should now be lit and a READY message should 

have been printed. 

3. When turning the printer off, wait at least 3 seconds before turning 

the printer back on. 

Printing a Self-Test The print head and ribbon can be tested only after inserting paper.  Do 

not print without paper.  To print a self-test follow these steps. 

1. Make sure the printer is in the OFF position. 

2. Depress power switch until it reaches PAPER FEED position. 

3. Hold the switch in the PAPER FEED position until the LED light 

goes on and the printer starts to operate.  Release switch. 

4. To stop the printer during the self-test or at any other time, turn the 

power switch to the OFF position and wait 3 seconds to turn it back 

on.  
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Installing the Paper The C-23 printer uses a 2.25-inch roll paper, available as Part Number 

215-051-00.  To install a roll of paper in the printer compartment, 

follow these steps. 

1. Press the power switch to the OFF position. 

2. There are small grooves embossed on the printer cover, push down 

on the grooves using both your index fingers.  The printer cover will 

tilt up, then lift the lid completely off. 

3. Unroll several inches of the paper.  Cut a straight edge on the paper 

roll if it is jagged.  This will facilitate the entry of the paper into the 

printer. 

4. Slide the paper through the slot connecting the paper compartment 

and the printer compartment.  You can slide it in about one-quarter 

inch before it stops.  

5. Press the power switch to the ON position and wait for a few 

seconds. 

6. While holding the paper in place, press the power switch to the 

PAPER FEED position.  The printer will activate, and a rubber roller 

will pull the paper into the printer compartment.  Hold the switch in 

the PAPER FEED position until the paper emerges from the top of 

the printer mechanism.  When an inch of paper has emerged from the 

top of the printer, release the PAPER FEED button. 

7. Now pull the paper through the printer, until several inches are 

exposed. 

8. Replace the printer cover by sliding the paper through the slot in the 

printer cover.  Push the back of the printer cover down and into 

place.  Press the front of the printer cover down to lock in place. 

9. Put the paper roll holder into the paper roll and place the holder onto 

the grooves near the back of the printer.  Turn the paper roll so as to 

take up any slack in the paper feeding to the printer.  Make sure the 

roll of paper moves freely.  If it does not move freely, the paper will 

jam and will possibly damage the printer mechanism. 

 

Installing the Cartridge 

Ribbon 

When printing becomes faint or difficult to see, the cartridge should be 

replaced.  The ribbon is available as Part Number 212-006-00.  To 

install a cartridge ribbon in the printer, follow these steps. 

1. Press the power switch into the OFF position. 

2. Remove the printer cover following the procedures above.  
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Installing the Cartridge 

Ribbon, continued 

3. Push down on the right side of the ribbon cartridge (marked "PUSH") 

and remove the cartridge. 

4. Install the new cartridge.  Be sure the ink cartridge is inserted firmly 

to prevent weak or irregular printing.  The cartridge must be properly 

seated and aligned for best printing. 

5. Turn the cartridge "knob" (marked by an arrow) clockwise to stretch 

the ribbon. 

6. Replace the cover following the procedures above. 

7. Replace the paper. 

You may also insert the ribbon cartridge if there is already paper in the 

printer.  Follow the steps above.  Slide the cartridge over the paper and 

into the printer compartment.  Be sure the paper goes between the ribbon 

cartridge and the ink ribbon. 

 

If ribbon ink gets on the printer case, wipe it off 

immediately.  Once it dries, it is difficult to 

remove. 

Clearing a Paper Jam If paper jams in the C-23 Printer, follow these steps to clear the jam. 

1. Press the power switch into the OFF position. 

2. Remove the printer cover following the procedures on the previous 

page. 

3. To remove the paper roll, lift the paper roll away from the printer 

housing.  With a pair of scissors cut the paper feeding to the printer.  

Try to make the cut as square as possible to facilitate the next 

reloading of the paper.  Now pull the remaining paper through the 

printer mechanism.  Be sure to pull the paper from the front (paper 

cutter side). 

 

Never pull the paper backwards from the printer. 

4. Carefully clear the jam, and replace the printer cover. 
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Printing a Report The C-23 Printer can print a report whenever and as often as needed. 

Printing a report does not erase or change the information stored in the 

data recorder.  

A full report or a summary can be printed for either a single customer 

or all customers. Table 4-1 shows the possible types of report 

selections.  

Follow these steps to print a lift report from the data recorder. 

1. Connect the printer to the data recorder printer connector.   

2. Turn on system power.  

3. Press the ENTER button while the Run screen is displayed. The print 

format selection screen appears. 

    Print Format 

Format: <Summary>  

4. Use the Right or Left keys to select Summary to print summary 

information about the lifts, or select Report to print a full lift report.  

5. Press ENTER to enter your selection and display the next screen, the 

customer selection screen.  

  Select Customer:  

<HAYES ENT>    

6. Press the Right or Left key to loop through the list of customer until 

the desired name is displayed, or display ALL to print data for all 

customers.  

7. Press ENTER to enter your selection and print the report. 

 

Table 4-1    Report types and their screen selections 

Report type FORMAT screen CUSTOMER ID 

screen 

Full report, all customers REPORT ALL 

Full report, one customer REPORT <customer> 

Summary, all customers  SUMMARY ALL 

Summary, one customer SUMMARY <customer> 
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Printing in KG Units  

When printing in KG units from the C-30 to the C-

23 it is required that the units be reset each time 

that the C-30 is powered off and on.  Go to the 

Units entry and using the left and/or right arrow 

buttons change the entry to LB then back to KG.  

Press Enter to accept the KG legend.  You are 

now ready to return to the Run screen and print 

your report. 

Reading a Report The information printed in a data recorder report or summary depends 

on the options you select when you request the report. All reports show 

sections that contain company data and summary flight statistics. A full 

report includes sections with detailed lift logs by customer.  

The various report sections contain the following information. 

 The report header contains the information stored in Lines 1 – 6 of 

the Company Data menu. 

 The customer header lists information stored in the Setup menu, 

including customer identification and location, and aircraft and pilot 

identification. 

 The date is the date the information was stored. 

 The flight detail includes a header with flight number, start time, end 

time and duration; lift detail for each lift, including lift number, load, 

start time, load and time minimum designator, and turn time; and an 

end-of-flight footer. 

 The flight summary supplies the number of flights and lifts for the 

customer, and totals and averages for flight time, weight, and turn 

time. 

 The codes for minimum settings are automatically assigned by the 

system whenever a lift is performed with a different combination of 

minimum load and minimum lift time. These codes are designated by 

letters, starting with A, that appear next to the start time in the lift 

detail. An asterisk * indicates the weight of a load that was captured. 

 The report footer shows the model number and manufacturer 

information for the printer. 

Figure 4-1 is an example of a full report from a data card storing 

information about two customers; Figure 4-2 is a summary for one of 

those customers. Table 4-2 shows which report sections are printed on a 

report and a summary. 
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Figure 4-1    An example full report 

            

           ************************  

          * Totals & Averages    *  

           ************************  

      Customer 1      Flights:    2  

Report Header        ROTOR-TO-ORDER  Flight Summary      T Flt Time: 00:03:59  

      HELICOPTER SUPPORT        A Flt Time: 00:01:59  

(from Lines 1 – 6 of      13915 NW 3
rd
 Court        Lifts:      4  

the Company       VANCOUVER WA 98685        T Weight:   20190LB  

Information menu)      PHONE 360-546-3072        A Weight:   5047LB  

      FAX   360-546-3073        T Trn Time: 00:03:34  

            A Trn Time: 00:00:53  

     ***********************       ********************  

Customer 1      Customer: TERRY T.  Customer 2      Customer: JASON  

Header      Location: ZONE 102  Header      Location: HILL 282  

       Aircraft: ONB-07970        Aircraft: ONB-07970  

      Pilot ID: KARSTEN        Pilot ID: KARSTEN  

     ***********************       ********************  

    Date    =  Date: 04/04/2000  =           = Date: 04/04/2000 =  

        -----------------------          --------------------  

Flight          Flight:  1  Flight          Flight: 1  

1    Header      Start: 08:39:50  1    Header      Start: 08:45:31  

          End: 08:41:20            End: 08:48:33  

          Duration: 00:01:30            Duration: 00:03:02  

                --------                        --------        

    Lift       Lift:  1    5100 LB+      Lift       Lift:   1    1250 LB+  

    Detail      Start: 08:40:00A      Detail      Start: 08:45:58C  

          Turn Time: 00:00:39            Turn Time: 00:00:31  

          Lift:  2    5100 LB+            Lift:   2    1250 LB*  

          Start: 08:40:39A            Start: 08:46:29C  

          Turn Time: 00:00:41            Turn Time: 00:00:46  

    Footer      -- Flight  1 End--      Footer      -- Flight 1 End--  

         --------------------           --------------------  

          Flight  2      ************************  

    Header      Start:      08:41:23      * Totals & Averages    *  

          End:        08:43:52      ************************  

Flight          Duration:   00:02:29  Customer 2      Flights:    1  

2                --------  Flight Summary      T Flt Time: 00:03:02  

         Lift:   3     5000 LB*        A Flt Time: 00:03:02  

         Start: 08:41:38A        Lifts:      2  

         Turn Time: 00:01:23        T Weight:   2500LB  

    Lift      Lift:   4     4990 LB+        A Weight:   1250LB  

    Detail     Start: 08:43:01A        T Trn Time: 00:01:17  

         Turn Time: 00:00:51        A Trn Time: 00:00:38  

    Footer      -- Flight 2 End--       ====================  

          --------------------        Lift Minimum Codes  

            Codes for the      A = 0300 LB 005 Sec  

              the minimum load      B = 0500 LB 005 Sec  

             and time settings      C = 0500 LB 010 Sec  

          used      * = Captured Lift 
  + = Acc Corrected 

  % = Averaged Lift 

 

               ====================  

        Report Footer           C-23  DATA  

             RECORDER/PRINTER  

             ONBOARD  SYSTEMS  

             Vancouver Washington  
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Figure 4-2    An example summary for Customer 1 

        

        

 Report Header        ROTOR-TO-ORDER   

       HELICOPTER SUPPORT   

      13915 NW 3rd Court   

        VANCOUVER WA 98685   

        PHONE 360-546-3072   

        FAX   360-546-3073   

          

      ********************   

 Customer 1      Customer: HAYES ENT   

 Header      Location: 40 NORTH   

        Aircraft: N1234E   

       Pilot ID: R BIVINS   

     ********************   

 Date     = Date: 04/04/2000  =   

     ********************   

       * Totals & Averages*   

     ********************   

 Customer 1      Flights:    2   

 Flight Summary      T Flt Time: 00:03:59   

       A Flt Time: 00:01:59   

       Lifts:      4   

       T Weight:   20190LB   

       A Weight:   5047LB   

       T Trn Time: 00:03:34   

       A Trn Time: 00:00:53   

      ====================   

 Report Footer           C-23  DATA   

        RECORDER/PRINTER   

        ONBOARD  SYSTEMS   

        VANCOUVER WASHINGTON   

        

        

 

 

 

Table 4-2    Sections printed on a report or a summary 

Report section REPORT SUMMARY 

Report header  X X 

Date X X 

Customer header X X 

Flight information  X  

Flight summary X X 

Codes for minimum settings X  

Report footer  X X 
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Section 5  

Using the Data Card 

The Data Card is used to retrieve data that is generated by the weighing 

system and the data recorder. This section describes the data card and its 

use. Here are the topics in this section. 

 Inserting the Data Card shows how to insert the data card into the 

data recorder or data card reader. 

 Erasing the Data Card describes how to erase information that is 

stored on the data card. 

 Memory Capacity of the Data Card describes the type and amount of 

information that is stored on the data card. 
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Copying the System Memory with the Data Card 

The data card is used to transfer the information contained in the data 

recorders internal memory to the office PC. The card should not be left 

in the data recorder when not transferring data. Transferring data to the 

data card does not erase the data recorders internal memory. 

To insert the data card refer to Figure 5-1 and follow these steps. 

1. Orient the card such that the card arrow is pointing towards the Data 

Card slot with the arrow on the key pad side, as illustrated in Figure 

5-1. It is possible to put the card in backward (with the arrow 

opposite the key pad) but the system will not transfer data in this 

orientation.  

2. Gently guide the card straight into the slot until it stops. Do not force 

the card. 

When a Data Card is inserted into the C-30, the system checks to see if 

data is stored on the card. If there is, a message is displayed indicating 

that data is stored on the card. Press the ENTER key to overwrite or 

erase the data. A message will appear when it is safe to remove the card. 

The C-30’s memory is not erased by this process. Each time the card is 

inserted the entire contents of the C-30 memory is transferred to the 

card. 

Figure 5-1    Inserting the data card 

 

 
 

Arrow pointing 

towards the keypad 
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Memory Capacity of the Data Card 

The Data card has a memory capacity of 1 MB. The card will store 

information for approximately 60,000 lifts.  
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Section 6  

Using the Optional Software 

This section describes how to use the optional software. 

 

Opening WinHook  

Click on the WinHook icon to open the program, The screen should look 

like this: 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 
 

 



 

6-2  Data Card System Owner's Manual 

Retrieving Data  

There are three ways to retrieve data. Data can be read from a Data Card, 

a serial port or opened from a previously saved file.  Refer to 

Downloading Data from a Data Card, Downloading Data from C-30 

Serial Port and Opening a File for explanations. 
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Downloading Data from a 

Data Card 

Read Card from the File menu will allow you to download the 

information on the inserted data card.   

1. Select Read Card from the File Menu 

If there is a problem reading the data card, a window will appear that 

says: “No data card found. Please make sure the card is properly 

inserted.”  Ensure that the data card reader is properly installed in 

the computer parallel port and that the data card is correctly installed 

in the card reader. Repeat Step 1. 

2. The screen should look similar to this: 

  

A summary box in the upper right hand corner displays summary 

information for a particular customer and location. In the upper left hand 

corner you can select different customers and different locations.  
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The bottom half of the screen displays the lift records for a particular 

customer and location. Double click a particular flight to view the 

individual lifts of the particular flight. Double click again to collapse the 

lift details. 
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Downloading Data from 

C-30 Serial Port 

C-30 data can be downloaded directly to a PC without using a data card. 

The download is completed by using a serial cable, P/N 270-099-00. 

To download data from the C-30 Data Recorder to a PC, follow these 

steps.  

1. Connect the C-30 Data Recorder to a PC by using serial cable, P/N 

270-099-00. 

2. Open WinHook program. 

3. Select Options from the Edit menu. Select the applicable COM port.  

4. Select Read Serial Port from the File menu. 

5. The data will be displayed as soon as the download is complete. 

6. Once the data is downloaded you can print, save or export the data 

as explained in this section. 

 

The C-30 Data Recorder cannot perform a 

download while flying, you must land in order to 

end the flight. Also, it is not possible to download 

data to a data card and to a PC via the serial port 

simultaneously.  
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Opening a File 

Open File from the File menu will allow you to open any file with a 

.ONB extension. 

1. Select Open File from the File Menu. 

2. Choose a file with a .ONB extension 

 

3. Click Open to open the file. 

 
 

 



 

Data Card System Owner's Manual 6-7 

Saving Data 

Save As from the File menu will allow you to save the file as a .ONB 

extension.   

1. Select Save As from the File Menu. 

 

2. Select a location and name for the file. 

3. Press okay to save and return to the main screen.  
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Exporting Data 

Export Data from the File menu will allow you to save the data as a text 

file. This will allow you to open the data in a word processing or 

spreadsheet program. The data can be exported as a comma or tab 

delimited file.    

1. Use the options menu to select a comma or tab delimited file. Refer 

to Options in this section. 

2. Select Export Data from the File Menu. 

 

3. Select a location and name for the file.  

4. Press okay to save and return to the main menu. 
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Printing a Report 

Print Report from the File menu will allow you to print the data. You can 

print a particular customer and location or you can print all customers 

and locations. You can also print a summary or a detailed report. 

1. Select Print Report from the File Menu. 

 

2. Select the desired print location. 

3. Choose a particular customer or select all customers. 

4. Choose a particular location or select all locations. 

5. Select the report type, summary or detailed. 

6. Select the report font and font size. 

Figure 6-1 is an example of a detailed report. 
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Figure 6-1    Typical customer report 

      

 HELICOPTER SUPPORT     

 1234 AIRPORT ROAD    Report 

 PORTLAND  OR 97229    header 

 (503) 123-4567     

  ________________________________________________________________________     

      

    Customer:   J.APLSEED  Pilot:   J. JENSEN    Customer 

    Location:  HILL 282 Aircraft: N12345678    header 

  ______________________     

      

   Flight Date Start Duration Lift Load (lb) Start Time Turn Time Notes     

  Date/Time Change: 03:24:2000  00:03:56     

   1 03/24/2000 14:49:25 00:05:27      

  1 1020 14:49:42 00:00:30 (std)1     

  2 1020 14:50:12 00:00:30 (avg) 1    Flight 1 

  3 1010 14:50:42 00:00:30 (std) 1    detail 

  4 1010 14:51:12 00:00:30 (std) 1     

  5 1020 14:51:42 00:00:34 (std) 1     

  6 1020 14:52:16 00:00:26 (avg) 2     

  7 1020 14:52:42 00:00:30 (std) 2     

  8 1020 14:53:12 00:00:30 (std) 2     

  9 1020 14:53:42 00:00:30 (std) 2     

  10 1020 14:54:12 00:00:30 (cap) (std) 2     

      
   2 03/24/2000 15:07:16 00:06:10      

  11 1350 15:07:41 00:00:40 (std)2     

  12 1350 15:08:21 00:00:40 (std) 2    Flight 2 

  13 1360 15:09:01 00:00:40 (std) 2    detail 

  14 1340 15:09:41 00:00:40 (std) 2     

  15 1340 15:10:21 00:00:40 (std) 2     

  16 1350 15:11:01 00:00:40 (avg) 2     

  17 1350 15:11:41 00:00:40 (avg) 2     

  18 1350 15:12:21 00:00:40 (std) 2     

  Date/Time Change: 03:24:2000  17:56:59    Date/Time Change 

               _____________________________________     

      

 Total Flights: 2 Total Lifts: 18     

 Total Flight Time: 00:11:37 Total Lift Time: 00:10:20    Flight  

 Average Flight Time: 00:05:48 Average Lift Time: 00:00:34    summary 

      

  Average Weight (lb): 1,090 Total Weight (lb): 19,620     

    ____________________________________________________________________________________     

      

  Lift recognition thresholds:    Lift 

  1   400 lb    15 seconds    Thresholds 

  2   400 lb    5 seconds     

      

 05/29/2000: Page 1    Report 

 WinHook (C:\Program Files\WinHook\Cascade Cedar.onb)    footer 
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Reading a Report  

The System uses the following rules to structure a report. 

 If the customer, location, pilot, date or aircraft ID changes, a banner 

line is printed showing the change, and the lift count and summary 

data is restarted. 

 The notes column next to each lift shows the method used to record 

the lift and the lift minimums. See the section How Lifts Are 

Recorded for an explanation of the items in parentheses.  
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Editing the Report 

Header 

Report header from the Edit menu will allow you to change the heading 

on your reports.  

1. Select Header from the Edit Menu 

2. A window with your own heading that was previously entered in the 

data recorder will be displayed: 

 

3. Edit the header. 

4. Press okay to save and return to the main screen. 

 

This procedure does not change the data on the 

data card.  It only changes the way files are saved 

or printed. 
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Options 

Options from the Edit menu will allow you to set Export File delimiter 

options, Lift Record Display and COM Port options. 

1. Select Options from the Edit Menu 

 

2.  Choose whether you would like to export files delimited by a comma 

or a tab. 

3. Choose whether you would like lift records expanded or collapsed 

by default. This applies when a file is saved and later opened again. 

If you select expanded lifts, the lifts will be automatically shown in 

the main screen. If you select collapsed lifts, the lifts will not be 

shown and in order to view them you will have to double click on 

the flight.  

4. Select the appropriate COM Port. 

5. Press okay to save and return to the main screen. 
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Section 7 

Maintaining the System 

This section describes the maintenance procedures you should observe 

to obtain maximum life and accuracy from the data card system. It also 

includes some trouble-shooting hints should problems occur with the 

system. 

Data Recorder Care 

The data recorder does not require periodic maintenance. 

Follow these guidelines in caring for the data recorder. 

 Keep the data recorder dry to extend its useful life. During wet 

weather, remove the unit from the aircraft, or cover it to reduce the 

possibility of water absorption.  

 

Do not open the data recorder. Opening the data 

recorder voids its warranty. There are no user 

replaceable parts in the data recorder.  

Cable and Connector Maintenance 

Follow these guidelines for cable and connector maintenance. 

 Check cables and connectors periodically for signs of wear. Replace 

cables that have worn through the foil shield. 

 Attempt to identify and correct the causes of cable wear including 

bending, shearing, and chafing.  

 Cover and protect the connectors when not in use to prevent 

corrosion and mechanical damage to the pins. 
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Troubleshooting 

This topic lists problems you may encounter when using the Data Card 

System, and describes possible solutions. 

Problem Corrective Action 

Power is on but the data 

recorder display does not 

show a readout. The unit 

appears to be dead. 

1. Check the fuse or circuit breaker between the positive battery wire 

and the data recorder. Replace the fuse if it is faulty.  

2. Check the entire power cable for damage, corrosion or a faulty 

connection. Clean or replace wiring if problems are found.  

3. Reset the contrast settings as the contrast may be set to light to see.  

After power-up wait at least 1 minute.  Then enter the following 

key sequence: 

 Press down arrow + up arrow together (1) one time 

 Press up arrow (3) three times 

 Press “Enter” (1) one time 

 Press down arrow (1) one time 

 Press “Enter” (1) one time 

 Press “Reset” (1) one time.  After this step, the bottom bar of the 

screen should be half filled with boxes. 

 Press “Enter” (1) time 

4. If there is no response to these solutions, refer to the Appendix for 

instructions for returning the unit to the factory. 

Numbers appear on the 

display but they do not 

change with weight or 

when a key is pressed. 

This problem is caused by a momentary burst or lapse of electrical 

power, causing a break in the flow of the program in the data recorder.  

1. The problem can usually be reversed by shutting off the data 

recorder power for several seconds. 

2. As a long term solution, ensure that all electrical wiring is secure 

and free of corrosion, and install an electrical filter. 
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Troubleshooting, continued 

This topic lists problems you may encounter when using the WinHook 

software program, and describes possible solutions. 

Problem Corrective Action 

You receive the message, “No 

Data card was found.  Please 

make sure the card is 

properly seated.” 

Check the card reader’s connection to the parallel port.  Check to make 

sure the data card is properly seated.  

Replace batteries.   See Replacing your Data Card Reader’s Batteries. 

 

You receive the message, 

“Error parsing data stream: 

multiple setup sectors” 

Defective data is on the card.  Complete the following steps in order, 

checking to see if the error still exists after each step, until you no longer 

receive error.  

1. Down load new data. 

2. Reformat memory. 

3. Re-initialize C-30.  

You receive the message, 

“Warning: No setup data 

was found” 

1. Serial cable is damaged or wired incorrectly.  Contact Onboard 

Systems. 
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Section 8 

Installation Authorization 

The Data Card System installation is authorized by the Federal Aviation 

Administration (FAA) for use with all Onboard Systems Electronic Load 

Weigh Systems. 

FAA Letter of Authorization 
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Appendix 

This appendix contains the following information for the Data Card 

System. 

 Specifications 

 Ordering information 

 Limited warranty 

 Return instructions 

 



 

A-2  Data Card System Owner's Manual 

Specifications 

The tables in this section give the specifications for the data card system 

components and optional equipment. 

Physical Specifications Table A-1 shows the physical specifications for the data card system 

components. 

Table A-1    Physical specifications 

Component Height Width Depth Weight 

C-30 Data Recorder 3.1 in 

7.9 cm 

5.75 in 

14.6 cm 

1.55 in 

3.9 cm 

1.0 lb 

454 g 

C-23 Printer 2.0 in 

5.1 cm 

4.0 in 

10.2 cm 

4.5 in 

11.4 cm 

12 oz 

340 g 

Data Card 0.6 in 

1.5 cm 

1.78 in 

4.5 cm 

0.07 in 

1.8 mm 

0.1 oz 

2.8 g 

Data Card Reader 0.75 in 

1.9 cm 

2.30 in 

5.8 cm 

2.25 in 

5.7 cm 

1.5 oz 

43 g 
 

 

 

Electrical Specifications Table A-2 shows the electrical specifications for the data recorder and 

the optional printer. 

Table A-2    Data recorder electrical specifications 

Characteristic Specification 

Operating voltage 18 – 30 Vdc 

Current consumption 

    C-30 Data Recorder 

    C-23 Printer 

 

250 mA 

1.5 A continuous, 5 A start up  

Storage temperature -40° – 158°F  (-40° – 70°C) 

Operating temperature  

    C-30 Data Recorder 

    C-23 Printer 

 

-5° - 158°F (-20° - 70°C) 

41° - 104°F (5° - 40°C) 

 

Tables A-3, A-4 and A-5 show the connector pinouts of the Data 

Recorder and the Load Weigh System components.  

Table A-3    Data Recorder Pin Out 

Connector to Internal Harness  Connector to C-23 Printer 

Pin Color Function  Pin Color Function 

1 Black Ground  1 Black  Ground, Aircraft 

2 Blue Capture SW  2 Blue +5V 

3 Red Power  4 Red +28V, Aircraft 

4 Brown Flight SW  5 Shield Shield 

5 Shield Shield  6 White RxD 

7 Green Clock  8 Green TxD 

9 White Data  9 Brown Ground, C-30 
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Table A-4    C-39 Indicator Pin Out 

Pin 

Letter   

 

Function  

A + 28 VDC In  

B - Load Cell Signal 

C + Load Cell Signal 

D + Load Cell Excitation 

E Load Cell Common  

F Analog Out Common 

G + Analog Out 

H Hook Open 

J Data Recorder Clock 

K Data Recorder Data 

L Shield  

M Back Light Common 

N Back Light Source 28 VDC 

P Aircraft Ground 

R Not Used 

Table A-5    Load Cell Pin Out 

Pin 

Letter 

Wire Color 

A Red 

B Green 

C White 

D Black 

E Shield 
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Ordering Information 

Order additional data card system components, accessories, and supplies 

by quantity and the part number shown in Table A-6. All items can be 

ordered separately. 

Table A-6    Ordering information 

Description  Part number 

Hardware components C-30 Data Recorder 210-189-00 

 C-23 Printer 210-100-00 

 Data Card 475-021-00 

 Data Card Reader 210-195-00 

Software components Software, IBM PC and 100%-compatibles 100-050-00 

Accessories  Data Card System Owner's Manual 120-089-00 

 Capture switch wire 270-019-00 

 Flight-time switch wire 270-022-00 

 Serial Cable 270-099-00 

Supplies Roll paper for C-23 Printer 215-051-00 

 Cartridge ribbon for C-23 Printer 212-006-00 
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Limited Warranty 

ONBOARD SYSTEMS Data Card System components are warranted to 

be free from defects in workmanship and materials for a period of one 

year from the date of purchase. The components are warranted to 

function as intended when properly installed and used for their intended 

purpose. Parts which prove to be defective are repaired or replaced free 

of charge FOB factory at the manufacturer's option if the following 

conditions have been met. 

 No repairs have been attempted by other than Onboard Systems 

personnel. 

 The system or component is returned properly packaged, insured, 

with transportation charges prepaid. 

 After examination, Onboard Systems personnel are satisfied that the 

defects were not caused by abuse, and that the components were not 

subjected to conditions that violate system specifications. 

The following are specifically excluded from this warranty. 

 Software 

 Cables 

This warranty covers only the original purchaser. In no event shall 

Onboard Systems be liable for indirect, special, incidental or 

consequential damage resulting from the use of this product, even if 

Onboard Systems has been advised of the possibility of such damage. 

Each user must satisfy himself that the system is suited to his needs and 

is performing according to his requirements. 
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Instructions for Returning Equipment to the Factory 

If an Onboard Systems product must be returned to the factory for any reason (including 
returns, service, repairs, overhaul, etc) obtain an RMA number before shipping your 
return.   

 
An RMA number is required for all equipment 
returns. 

 To obtain an RMA, please use one of the listed methods. 

 Contact Technical Support by phone or e-mail 
(Techhelp@OnboardSystems.com). 

 Generate an RMA number at our website: 
http://www.onboardsystems.com/rma.php 

 After you have obtained the RMA number, please be sure to: 

 Package the component carefully to ensure safe transit. 

 Write the RMA number on the outside of the box or on the mailing label. 

 Include the RMA number and reason for the return on your purchase or 
work order. 

 Include your name, address, phone and fax number and email (as 
applicable). 

 Return the components freight, cartage, insurance and customs prepaid 
to: 

Onboard Systems 
13915 NW 3rd Court 
Vancouver, Washington 98685 
USA 
Phone: 360-546-3072 

 

mailto:Techhelp@OnboardSystems.com
http://www.onboardsystems.com/rma.php
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